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Introduction

What is 
MyVision? 

MyVision is software developed by ESA Elettronica for Building 
Automation. Simple yet powerful, it is devised for the new se-
ries of Visualyser terminals and is highly advanced, meeting 
new needs in the field of building automation.

The new 
Visualyser line 

ESA's new line of products is called Visualyser (http://www.vi-
sualyser.com).
It is designed to make the ESA terminals not only a great form 
of technology but also a valuable asset to any home environ-
ment, from humble family abodes to luxury residences, or 
rooms in hotels and/or any public structure where technical 
needs demand it.
The salient features of the MyVision are its great ease of use 
and simple intuitive interface.

What is 
MyVision for?

Conceptually speaking, MyVision allows the customer to inte-
ract with the terminal; it is the tool that allows the user to play 
with ideas on the panel and create all manner of projects, both 
small and large. The software is universal - it can be program-
med on all ESA Visualyser terminals regardless of their func-
tions and technical properties.
MyVision allows you to create a project with all the details re-
quired to run the associated application. When completed, the 
project can be downloaded and installed on the panel, and the 
panel is then ready for use. 
MyVision assists the user during all stages of the project: from 
creation to editing, compilation and installation on the termi-
nal.

The Manual This manual serves to assist ESA customers at all times. It de-
scribes and explains the various functions of the software. It 
is intended for the typical user of ESA products, whether first-
time buyers or people who are already familiar with ESA's sof-
tware.
Key concepts, instructions, examples and screen-shots are gi-
ven for each topic and function.
In the MyVision manual, ESA introduces a new form of multi-
media that it has never used before: it consists of giving 
examples in video format. The video clips illustrate the infor-

1.
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MyVision 
mation given in the paper manual in a clear and realistic man-
ner. They are effectively "mini lesson video clips" which allow 
the user to better understand the information already given in 
form of text and "screen shots". There is a video clip at the 
end of each paragraph. To view a video clip, you simply need 
to click on the web cam icon :

The user can watch, pause, stop and rewind a video clip until 
he has fully understood the content.

If you should find some problems in viewing movies, please 
install the codec “xvid " (open source) by clicking on the fol-
lowing :

Conventions In the interest of clarity and easy consultation, we shall use 
simple notes with which you can familiarize yourself from the 
start. The table below contains all the notes used throughout 
the manual :

The table below contains all the notes used throughout the 
manual :

Table 1: Diagram of conventions

Note Meaning
Indicates there is a note; notes are gi-
ven, when necessary, to provide advi-
ce or clarify common doubts.
Indicates a video file in ".avi" format il-
lustrating the aspect of the MyVision 
software mentioned in the name of the 
paragraph.
Indicates you can watch a video file in 
".avi" format. To open the file, click on 
the webcam icon.
- User Manual - rev. 2.0
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The information in this document is subject to modification 
without forewarning and is not binding for ESA elettronica 
S.p.A.
All the products are commercial or registered brands of the re-
spective owners.

ESA Elettronica 
technical 
assistance

If you have any doubts concerning the use of MyVision or 
ESA's products in general, please feel free to contact the ESA 
Elettronica technical assistance service, available Monday to 
Friday, from 8:30 am to 12:30 pm and from 2 pm to 6 pm.
Telephone number: (+39) 031/757400
Fax: (+39) 031/751777
Email: customer.care@esahmi.com

Attention: we advise you to make a note of the currently installed 
version of MyVision and keep this at hand whenever you contact the 
ESA Technical Assistance service. The software version is stated in 
the main menu opened by clicking on "?">Information.
MyVision - User Manual - rev. 2.0
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Installation and registration

This chapter describes the first step of the MyVision procedu-
re: software installation and registration.
Stated below are the system requirements needed to run the 
application correctly and the main points of the installation 
phase.

Minimum 
requirements

Below are the minimum requirements for using MyVision on 
your machine :

                                                                                                    
                                                                        
 

Table 1: Minimum requirements

Type Requirement

Operating 
system

Windows® XP with Service Pack 2

RAM 
memory

1GB RAM

Processor Pentium IV o equivalent

Screen 
Resolution

1024*768

Space on 
Hard Disk

500 MB

2.
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MyVision 
Recommended 
requirements

Below are the recommended requirements for optimal use of 
the MyVision on your machine :

Table 2: Recommended requirements

Installing 
MyVision

Make sure your machine meets the minimum requirements. 
You can then install the MyVision.
Close or end any open applications.
Insert the DVD-ROM with the MyVision program.
This window opens automatically :

Type Requirement

Operating 
system

Windows® XP

Windows® Vista

Windows® 7

RAM 
memory

2 GB RAM

Processor Pentium IV or above

Screen 
Resolution

1024*768 or above

Space on 
Hard Disk

500 MB
- User Manual - rev. 2.0
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Select the required language. This window opens. To install 
MyVision, click on "Install MyVision" in the "MyVision suite" 
menu :

Follow the on-screen instructions to complete installation.

Registering 
MyVision

When the installation phase has ended successfully, this ima-
ge appears requesting you to register the software :
       MyVision - User Manual - rev. 2.0
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MyVision 
Insert the license code (shown on the box for the MyVision 
DVD). Click "Next". This image appears requesting you to en-
ter your details. Insert these and click on "Next" :

You need an Internet connection to complete registration. This 
image requests you to select the box if you have a "Proxy" 
connection. Make your selection then click on "Next" : 
- User Manual - rev. 2.0
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This image appears when registration has completed cor-
rectly. Click "Done" :

Note: Registration is not mandatory, but is strongly recommended as 
the user is then entitled to free downloads of future software ver-
sions. If you do not register, you will be prompted to do so whenever 
you use the MyVision.
       MyVision - User Manual - rev. 2.0
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Menu layout

In order to familiarize yourself with the functions of the MyVi-
sion, you need to first understand the work environment and 
the various menus.
The layout of the application is made up of the following are-
as: 

    • Main menu 
    • Icon bar 
    • Project tree
    • Work area 

In this chapter we will describe the general configuration of 
the software, with particular reference to the main menu and 
the icon bar: the basic tools for all actions in the MyVision en-
vironment.

The functions of the icon bar can also be accessed on the main 
menu.

Main menu The main menu allows you to execute the main tasks associa-
ted with configuration and projects.

It is situated at the top of the program window and is in a set 
position, so cannot be moved to another part of the page. 
There are various sub-menus you can scroll through; each 
sub-menu offers different functions which we will discuss fur-
ther on.

3.
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MyVision 
File Menu

Table 1: Functions of the File Menu

Icon Menu path Description of Function

File -> New 
Project

To create a new Wizard project  
(see chapter 4, “Creating a 
project with the Wizard” 
page 19)

File -> Open 
Project

To open an existing project 

File -> Save To save a project

ND1 File -> Save As
To save a project with a diffe-
rent name or in a different di-
rectory

ND1 File -> MyVision 
Properties

To change the directory where 
the projects are saved by de-
fault. This also allows you to 
edit the number of "Undo le-
vels", there are 20 by default, 
these can be between 1 and 
100.
- User Manual - rev. 2.0
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Edit Menu 

File -> Print

To print a project. There are va-
rious options: 
- Print the structure of the 
project
- Print the properties of all the 
devices
- Print the properties of the de-
vice selected
- Print all the pages of the devi-
ce
- Print the current page

ND1 File -> Close 
Project

To close a project

ND1 File -> Exit To exit the MyVision

1.Icon not available

Table 2: Functions of the Edit menu

Icon Menu path Description of Function

Edit -> Undo To undo the previous operation

Edit-> Redo To redo an undone operation

Edit -> Copy To copy a selected object

Edit -> Cut To cut a selected object

Edit -> Paste To paste a cut or copied object

Table 1: Functions of the File Menu

Icon Menu path Description of Function
MyVision - User Manual - rev. 2.0
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MyVision 
Project Menu

Table 3: Functions of the Project Menu

Device Menu

Icon Menu path Description of Function

ND1

1.Icon not available

Project -> Project 
Properties

To open the window containing 
the project details, the Name, 
Description, Author, Version 
and folder where the project is 
saved. It is possible to edit the 
information in this window.

Project -> 
Connection 
Management

To open the page for configu-
ring the device's connections. 
For instance, it is possible to as-
sign one or more communica-
tion protocols (see chapter 4, 
“Connection Management” 
page 31).
- User Manual - rev. 2.0
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Table 4: Functions of the Device Menu

Icon Menu path Description of Function

Device -> Device 
Properties

To open the window with these 
details concerning the device 
(see chapter 4, “Device Proper-
ties” page 46) :                                           
- Name, description, model and 
mode (horizontal or vertical)
- Name of the initial page
- View and/or enable or disable 
"Remote access to the device"
- The status of the communica-
tion ports and, if these are con-
nected to a protocol, their 
parameters

Device -> Edit 
pages 

To edit the pages of the device  
(see chapter 4, “Editing a page” 
page 52)

Device ->  Create a 
New Page

To create a new project using 
the "Wizard" (see chapter 4, 
“Creating a new page” page 51)

Device ->  Manage 
Variables

To open the page where you 
can manage the variables of the 
device; (see chapter 4, “Varia-
ble Management” page 57).
You can also create new varia-
bles  (see chapter 4, “Creating a 
new variable” page 53).

Device -> Manage 
Schedulers

To open the page where you 
can manage the Schedulers of 
the device;
(see chapter 4, “Scheduler ma-
nagement” page 142).
You can also create new Sche-
dulers (see chapter 4, “Creating 
a new Scheduler” page 139).
MyVision - User Manual - rev. 2.0
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MyVision 
"?" menu 

Device ->  Manage 
Scenarios

To open the page where you 
can manage the scenarios of 
the device; (see chapter 4, 
“Scenario management” 
page 136). You can also create 
new Scenarios (see chapter 4, 
“Scenario management” 
page 136).

Device ->  Manage 
Alarms

To open the page where you 
can manage the Alarms of the 
device. You can also create new 
sets of Alarms (see chapter 4, 
“Device alarm management” 
page 162).

Device ->  Test 
Device

To run the "Runtime" simulator 
that executes a real test of the 
project associated with the ESA 
device, after automatic compi-
lation of the same project (see 
chapter 4, “Test Device” 
page 243).

Device ->  
Transfer Project

To download the project on the 
ESA device after automatic 
compilation of the same project 
(see chapter 4, “Transferring a 
project to the device” 
page 249).

Icon Menu path Description of Function
- User Manual - rev. 2.0
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Table 5: Functions of the "?" menu

Icon Menu path Description of Function

ND1

1.Icon not available

? -> Help

To open the "Help" page for in-
formation on the part of the 
MyVision you are on at the ti-
me. It is also possible to open 
the Help page by pressing the 
"F1" key on your PC keyboard.

ND1 ? -> Information
To open the "Information" page 
on the MyVision. This states the 
installed software version.
MyVision - User Manual - rev. 2.0
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Project Management

The user can fully program the device with the MyVision sof-
tware for creating a project file.
The user can create a project file, edit it as required (using the 
functions described further on), save it and open it again later 
to make any additional changes.
This chapter describes how to create and manage projects fi-
les correctly with the MyVision software.
The first step when using the MyVision software is to create a 
new project from scratch.

Creating a 
project with the 
Wizard

The "Wizard" helps you to create your projects and install the 
various hardware components.
The Wizard can be opened in two ways:

    • Click on 
    • File->New on the main menu

Using the Wizard

Creating a project with the "Wizard" involves 5 steps:

Insert the main details of the project (Name, Description, Au-
thor and the directory where the project is to be saved.
Select the Type of Project ("Single Device" or "network" 
project involving several devices).
Select the Type of Device and its alignment (vertical or hori-
zontal).
Select the Type of Protocol to be associated to the device.
Confirm your selections (click the "Done" button).

There is a "Back" button on each page of the Wizard. You can 
click on this to go back.
The Wizard's "Start Page" opens when you start up the wi-
zard:

4.
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MyVision 
To create a project, simply click the Create button:  

On the next window you are requested to enter the main de-
tails of the project (name, description and author of the 
project). You can also select the folder where the project is to 
be saved. When you have done, click "Next" to continue :
- User Manual - rev. 2.0
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Single Device 
Project

First of all, you need to select the type of project. This can be 
a "Single Device" Project, or a "Home" Project. Make your se-
lection then click "Next" to continue :

You now need to specify the ESA device to be used for the 
project, and its alignment (vertical or horizontal).
Make your selection then click "Next" to continue :

At this point you have to select the type of communication 
protocol for the ESA device.
There are three different "communication standards" for the 
various protocols :
MyVision - User Manual - rev. 2.0
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MyVision 
    • Ethernet
    • KNX (Konnex)
    • Serial

To select a "communication standard", click on the drop-down 
menu shown below :
 

The devices in each category are sub-divided according to ma-
nufacturer; make your selection and click "Done".
To open the list of "Konnex" protocols when creating a project, 
select an ESA device with integrated "Konnex" port, e.g. 
YTAT1210 (see chapter 4, “Adding a protocol to the device” 
page 31).
All the data required to create the project has now been inser-
ted. MyVision opens this image where you can create a new 
project page :
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Click on the icon to watch the video for this section :

Home Project 
(network with 
several 
devices)

If you need to do a project for a building on several floors (e.g. 
a hotel), MyVision offers a simple and intuitive way of putting 
together a project quickly and efficiently.
First of all, you need to select the "Home" Project (network 
with several devices) then click "Next" to continue :
MyVision - User Manual - rev. 2.0
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MyVision 
This window opens. Determine the basic structure of the 
project by selecting one of the options available - "Floors", 
"Zones" and "Rooms". For example: select "Floors" and click 
on "Next" :
- User Manual - rev. 2.0
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You can create up to 40 floors in the initial configuration; du-
ring project management, however, there is no restriction to 
the number of floors.
There are three ways of editing the number of floors :

    • Click in the box containing the number "1" next to 
"Number of floors" and type in the required number.

    • Click on the triangle to the right of the number "1". Click 
and drag the triangle to the right until you see the re-
quired number

    • Click on the horizontal line to the right of the triangle 
and keep clicking until you see the required number.

For example, you want to enter 5 floors. The image is as fol-
lows. Click "Next" :
MyVision - User Manual - rev. 2.0
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MyVision 
The next page opens. Here you can enter "zones" or "rooms" 
for each floor you have just created:

For example, you select "Floor 1"; this lights up, allowing you 
to add a new ESA device to the three others mentioned above:

If for example you want to add 5 rooms on floor 1, click 5 ti-
mes on the "Add room" button :
- User Manual - rev. 2.0
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The rooms you have created appear in the project :

You now add an ESA device; click "Add another panel" :
MyVision - User Manual - rev. 2.0
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MyVision 
The page "Model and alignment of device" opens. Select the 
model of the ESA device and its alignment (vertical or horizon-
tal), then click "OK" :
- User Manual - rev. 2.0
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The selected device appears in the project :

Now click "Next" and MyVision opens a page where you need 
to select the protocol for the project (see chapter 4, “Adding 
a protocol to the device” page 31).

Click on the icon to watch the video for this section:

Opening an 
existing project

How to open a project that has already been saved:
Start the MyVision. The "Start-up page" appears:
MyVision - User Manual - rev. 2.0
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MyVision 
On the start-up page you can create a new project (see chap-
ter 4, “Creating a project with the Wizard” page 19) or open 
an existing project by clicking on the button "Open a project":

This window appears. Select the project you wish to open then 
confirm by clicking "OK":

It is also possible to open one of the "recent projects". MyVi-
sion lists the last 5 projects you have used. To open, simply 
click once on the round icon representing a folder :
- User Manual - rev. 2.0
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Click on the icon to watch the video for this section :

Connection 
Management

On the MyVision main page, you can open the page "Device 
connection management" by clicking on the icon at the top, on 
the main icon bar :

On the "Device connection management" page, you can add 
and remove communication protocols for the ESA device, or 
configure the settings and properties of protocols already in 
use for the project.

Adding a 
protocol to the 
device

"Local" network

The device is connected to a "local network" when it controls 
a single floor of the building.
It is possible to add 1 protocol for each serial port and one for 
each Ethernet port on the ESA device.
To assign a protocol to the ESA device, simply select one in 
the list of protocols on the right side of the screen. Click and 
drag it onto the ESA device. 
For example, you wish to add an Ethernet communication pro-
tocol; or, to be more precise, a CS1 CJ1 protocol :
MyVision - User Manual - rev. 2.0
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MyVision 
On the "Device connection management" page, your YT5T de-
vice still has a serial port (SP1 port) available.
You add a serial protocol by simply clicking the drop-down me-
nu shown below and select the "Serial" communication stan-
dard :

A list appears automatically stating all the "serial" protocols 
that can be assigned to the ESA device.
Select a protocol and drag it (pressing and holding the left 
button on the mouse) to the ESA device :

To add a Konnex protocol, the ESA device must have an inte-
grated Konnex port; for example, you can add an YTAT1210 :
- User Manual - rev. 2.0
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Open the list of "Konnex" protocols by clicking the drop-down 
menu :

Select the required Konnex protocol and drag it onto the ESA 
device :
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MyVision 
Click on the icon to watch the video for this section :

Global network The device is connected to a "Global Network" when this is 
used to control several floors in a building.
A "Global Network" allows you to add protocols using exclusi-
vely an Ethernet connection; it is possible to add up two 2 dif-
ferent categories of protocols.
Before dragging the protocol to the device, click on the red "X" 
to enable connection to the "Global Network" :

The connection to the global network is enabled. The "ETH1" 
on the ESA device has disappeared - this means we can no 
longer use the Ethernet port on the device as it is now con-
nected to the "Global Network" :

Enter the protocol. In the example, a CS1 CJ1 (Ethernet) com-
munication protocol is selected from the list of protocols (on 
the right of the image) and dragged onto the ESA device :
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As can be seen below, the protocol appears not in the same 
way as for the "Local Network", but on the left of the graphical 
representation of the Ethernet cable :

To add a second Ethernet protocol, you simply need to repeat 
the above procedure. In which case, the screen should appear 
as follows :

In the above image the YT5T device still has a serial port avai-
lable (SP1 port). To add a serial protocol (a "Local Network" 
connection), simply click the drop-down menu pictured below, 
selecting the "Serial" communication standard :
MyVision - User Manual - rev. 2.0
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MyVision 
A list appears automatically stating all the "serial" protocols 
that can be assigned to the ESA device.
Select a protocol and drag it (pressing and holding the left 
button on the mouse) onto the ESA device :

Lastly, confirm your changes by clicking "Done" : 

Click on the icon to watch the video for this section :

Eliminating a 
protocol

Move the cursor onto the protocol you wish to eliminate. This 
image appears :
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Click on "Delete" to eliminate the "CT Modbus TCP/IP" proto-
col:

This opens an "Information" page requesting your confirma-
tion. Click "Yes" :

The protocol is removed from the project :
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MyVision 
Click on the icon to watch the video for this section :

Protocol 
properties

To view and/or edit the properties of a protocol after having 
connected it to the ESA device, move the cursor onto the sa-
me protocol and this image appears :

Click on the "Properties" button to open the "Protocol Proper-
ties" window :
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The "Protocol Properties" window gives these options :

    • Information
    • Connection settings
    • Variables

Information

On the "Protocol Properties" page, click the "Information" but-
ton. This opens the window shown above with the details, the 
name and description of the protocol that can be edited.

Connection settings

The "Connection settings" option allows you to check the "na-
me", "value" and "format" of the protocol connection settings. 
The "value" field can be edited : 
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Variables

The "Variables" option allows you to view the list of variables 
for the protocol concerned. It is also possible to add, delete, 
edit, import and export new variables.

Adding a 
variable

To add a new variable for the selected protocol, click the "Add" 
button in the bottom left hand corner of the "Protocol Proper-
ties" page :

This image appears :
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You can now do the following :

    • Assign a name and description to the variable concer-
ned

    • Select the type of variable in the "Type" drop-down me-
nu

    • Select the data area in the "Data area" drop-down menu
    • Select the type of data in the "Type of data" drop-down 

menu

If for example you select the "Auxiliary area bit (A)" for the 
"Data area" :

This window appears. Note that two fields, "A" and "Bit", have 
appeared :
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MyVision offers a valid data range applicable to the "A" and 
"Bit" values. The "suggestion" is given in a box at the bottom, 
to the left :

The box stating the valid data range is useful as it can save 
time when designing your project,  it helps point you in the ri-
ght direction.
This feature of the MyVision also applies to the other options 
in the "Data area" field.

When you have determined the properties of the new variable, 
click "OK". This window opens :
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As you can see, the list of variables in the "Variables" area of 
the "Protocol Properties" page is no longer empty. You can 
now also read and/or edit the properties of the variable you 
have just created by clicking "Details" :

In the same window, you can edit the name of the variable by 
clicking the name of the same variable.

Click on the icon to watch the video for this section :

Deleting a 
Variable

The "Variables" option also allows you to delete a variable by 
pressing the "Delete" button :

If there is a list of variables, simply select the one you wish to 
delete :
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Then click "Delete" :

An "Information" message appears :

Press the "Yes" button. The selected variable is removed from 
the list.

Click on the icon to watch the video for this section :
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Import/Export Variables

The "Variables" option allows you to import a list of pre-deter-
mined variables in ".xls" format by clicking "Import":

This window opens. Select the file to import :

When you have done, click "OK".

MyVision allows you to export one or more variables in ".xls" 
format by clicking "Export" :

This window appears. Select the variables to export :
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Click "Next". This window appears. Select the folder where 
you wish to save the file to be exported :

When you have done, click "OK".

Device 
Properties

It is possible to access the "Device Properties" page in two 
ways : 

1) On the "Device" menu, click "Device Properties" :
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2) Click the "Device Properties" icon at the top on the main 
icon bar :

Information

On the "Device Properties" page, click the information button 
to open this window. It lists details concerning the ESA device, 
the name, description, model and alignment (horizontal or 
vertical) :
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Initial Page

On the "Device Properties" page, click the "Initial Page" button 
to select and configure one of the pages (if already added to 
the project) as the initial page :
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Remote Access

On the "Device Properties" page, click the "Remote Access" 
button to open this window: 

Select the "Enable remote access" checkbox to enable the re-
mote access function (to be covered in detail further on). En-
ter the Username; in this example, "USER1":
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Parameters of the device's connection ports 

In the project created in the example, we have chosen a de-
vice with 1 x SERIAL port and 1 x ETHERNET port. As can be 
seen in the two images below, it is possible to read the settin-
gs of the SERIAL connection with the respective protocols as-
signed to the communication ports :

There are also the settings for the ETHERNET connection :
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Creating a new 
page

When a new project is created with the "Wizard", MyVision 
opens a window to create a new project page :

Click the button indicated by the green arrow. This window ap-
pears :

As shown above, it is possible to add various elements to the 
project (control, adjustments, alarms, etc.) which are listed 
below and described further on in this chapter :
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    • Lights -Light control- (see chapter 4, “Creating a Lights 
page” page 62).

    • HVAC -Heating, cooling and ventilation control (see 
chapter 4, “Creating a "HVAC" page” page 90).

    • Irrigation -Irrigation control- (see chapter 4, “Creating 
an "Irrigation" page” page 108).

    • Scenarios -Scenario control- (see chapter 4, “Creating a 
Scenario page” page 122).

    • Schedulers -Scheduler control- (see chapter 4, “Crea-
ting a new Scheduler” page 139).

    • Hotel rooms -Hotel room control-(see chapter 4, “Crea-
ting a Hotel room page” page 145).

    • Alarms -Alarm control- (see chapter 4, “Creating an 
Alarm page” page 169).

    • Windows -Window, door, rolling shutter and curtain 
control- (see chapter 4, “Creating a Windows page” 
page 176).

    • Video -Video surveillance- (see chapter 4, “Creating a 
Video page” page 200).

    • Access -Access control- (see chapter 4, “Creating an Ac-
cess page” page 205).

Editing a page After creating a project page, it is possible to edit it in two 
ways for a new project using the "Wizard". MyVision opens a 
window where you can create a new project page :
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Creating a new 
variable

The "Variable configuration" window opens when you create a 
new page (see chapter 4, “Creating a new page” page 51) :

In this window, click the "Protocol" button in the bottom right-
hand corner. This window opens :
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Click the "Create a new variable" icon : 

This window opens :

You can now do the following :

    • Assign a name and description to the variable concer-
ned

    • Select the type of variable in the "Type" drop-down me-
nu

    • Select the data area in the "Data area" drop-down menu
    • Select the type of data in the "Type of data" drop-down 

menu
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Click "OK" when you have done the above. This window appe-
ars. The new variable is now shown under the name of the 
protocol :

You can also add a new variable on the "Protocol Properties" 
page (see chapter 4, “Protocol properties” page 38) by selec-
ting the "Variables" option (see chapter 4, “Adding a variable” 
page 40).

Click on the icon to watch the video for this section :
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Deleting a 
variable

Select the variable you wish to delete :

Click the "Delete variable" icon :

This message appears :

Click "Yes" to delete the variable.
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Variable 
Management

To manage a variable you need to have first created a page 
(see chapter 4, “Creating a new page” page 51) and assigned 
an element to the page (see chapter 4, “Creating a new page” 
page 51).
There are two ways of opening the "Variable Management" pa-
ge :

    • Click the "Device" menu on the main menu bar then se-
lect the "Device Variable Management" option (see 
chapter 3, “Device Menu” page 14)

    • Click the "Device Variable Management" icon :

The window is as follows :

Click the "Protocol" button in the bottom right-hand corner. 
The window is as follows :
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On this page, you can now create new variables (see chapter 
4, “Creating a new variable” page 53), or assign the variable 
to an object (in this case, an ON/OFF light).
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To associate the variable to the light in this example, select 
the variable and use the mouse to drag it onto the image re-
presenting the selected light :

You will note the image representing the light has changed - 
its coloured background is different and the shading has gone. 
Moving the cursor onto the image opens a pop-up table sta-
ting the properties assigned to the light.
These properties can be edited as follows:
Right-click on the image representing the light the properties 
of which you wish to edit. The window is now as follows:
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Click "Properties". This image appears :

The above image states the properties of the object. You can 
edit the name and add a description; and this image appears 
when you click the "Properties" button :

The window above gives the following options :

    • WRITING status
    • READING status 
    • Value off
    • Value on
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WRITING: click the drop-down menu to select the variable you 
wish to use from the list of variables created; you can then 
write a value in this variable (in this case, for the ON/OFF li-
ght, the values are "Off" and "On" :

The window above also allows you to create or delete, or even 
import a list of pre-determined variables, or export these 
using the icons at the bottom of the window (see chapter 4, 
“Creating a new variable” page 53 and (see chapter 4, “Dele-
ting a variable” page 56).

READING: it is possible to read the value of the variable, but 
not edit it. The same variable is used by default for "WRI-
TING".

Value OFF: it is possible to attribute a value to the "OFF" sta-
tus. The default value is "0".

Value ON: it is possible to attribute a value to the "ON" status. 
The default value is "1".

Click on the icon to watch the video for this section :
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Creating a 
Lights page

On the previous window, select the "Lights" icon with the 
mouse :

This window opens :

MyVision allows you to manage two types of Light :

    • On/Off lights (classic ON/OFF switch)
    • Adjustable lights (adjustable light intensity with poten-

tiometer)
In both cases, it is possible to manage 1 to 50 sources of light 
for each page created.
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ON/OFF lights

As an example, you are on the previous "Light Control" page 
and wish to add 2 x ON/OFF lights. This can be done in 3 dif-
ferent ways :

    • Click in the box containing the number "0" next to 
"Number of on/off lights" and type in the number "2"

    • Click on the triangle to the right of the number "0". Click 
and drag the triangle to the right until you see the num-
ber "2"

    • Click on the horizontal line to the right of the triangle 
and click 3 times. The number increases to 2

When you have done, the window is as follows :

Technical view of 
the ON/OFF light 
page

When you have done, click "Next". This window appears (Te-
chnical View). You can choose between three options :

    • View the elements as a simple set of buttons (in this ca-
se you can also select the background colour)

    • View the elements against a background image (in this 
case you can select a background image)

    • You can also give the page a title by editing the "Title" 
field
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If you select "View the elements as a simple set of buttons", 
you can select a background colour by clicking the white box 
"Select background colour"  the window is now as follows :

If you select the "View the elements against a background 
image", the window is as follows :
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On the same page, you can select a background image by cli-
cking the blue rectangle "Select background image" :
                                    

At this point, clicking "Done" will not select any image. The 
objects on the page are automatically shown against a light 
blue background where you can edit them as required.
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If instead you wish to have a background image, select the re-
quired image and then click "Done" :

The image is now as follows. You can change the name of the 
page (for instance, "Lights 001"), then click "Next" :
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Appearance of 
the ON/OFF 
lights

The page is called "Appearance of the on/off lights". You can 
edit the following properties :

    • Images
    • Button text
    • Options

Images

The "Images" area has two options :

    • Skin
    • Images

If you select "Skin" and click the drop-down menu, you can 
then choose between these options :

If you select "Images" you can select an image to be assigned 
to the button :
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On the next page you can select the image you wish to use :

Select the required image and click "Done".

Button text

This option allows you to attribute text to the button.
Select the "Display text on selected button" checkbox in the 
"Button text" area. You can now edit these parameters :

    • Colour
    • Size
    • Alignment
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Click in the box next to "Colour" to select the colour of the 
text:

Click in the rectangles next to "Size" to select the size of the 
text :
MyVision - User Manual - rev. 2.0



Chapter 4

Project Management 

70

MyVision 
Click in the rectangles next to "Alignment" to select where to 
put the text, at the centre, to the left or to the right :

Options

The "Options" window allows you to determine whether the 
buttons are read-only or configurable. 
A "read" button cannot be assigned variables, while a "read-
and-write" one can.
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The default image is :

Technical view of 
the ON/OFF light 
objects

Click "Next" to open the "Technical View" page that displays 
all the objects concerned :

Click the blue button above "Objects" in the top left-hand cor-
ner of the page. A tree menu opens where you can select the 
technical view of the buttons created :

On the same page, click the blue button above "Properties" in 
the top right-hand corner. A tree menu opens allowing you to 
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view the properties of the button selected in the left-hand me-
nu (Objects) :

You can also modify the position of the button on the page 
using the X and Y variables, and edit the width and height of 
the button using the W and H variables.
You can edit the values in the same 3 ways described earlier 
on :

    • Click in the box containing the number next to the va-
riable you wish to edit, and type in the required number

    • Click on the triangle to the right of the box. Click and 
drag the triangle to the right until you see the required 
number

    • Click on the horizontal line to the right (or left) of the 
triangle and keep clicking until you see the required 
number

You can also use the + and - buttons at the bottom of the page 
to zoom in or out of the page :
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If you wish to move a button, you can use the mouse by pla-
cing the cursor on the button, clicking and dragging it to the 
required place on the page.
Double-clicking on an object opens a page where you can edit 
its properties :
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Configuration of 
ON/OFF light 
variables

On the "Technical View" page, click "Next" to open the "Varia-
ble configuration" page : 

You will notice the objects on the page are pink in colour. This 
means they have not yet been assigned a variable. The first 
thing to do, therefore, is to create a variable (see chapter 4, 
“Creating a new variable” page 53).
Create the variable (in the example, "on/off light 1"). Select it 
with the mouse and drag it onto the selected button:  
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The button changes colour. The pink image disappears. You 
can move the cursor over the button to view the properties of 
the assigned variable :

Follow the same procedure to assign variables to the other 
buttons, after of course having created the variables concer-
ned (see chapter 4, “Creating a new variable” page 53).
On the "Variable configuration" page, you can view the objects 
in 2 different ways :

    • Page mode (by clicking the respective button) :

    • List mode (by clicking the respective button) :
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The properties of the objects can be edited in both cases (mo-
difying the reading/writing status by assigning different varia-
bles, managing variables, creating and eliminating variables, 
modifying the "on" and "off" values).

After entering all the data on the "Variable configuration" pa-
ge, click "Done" to return to the MyVision main page.

Click on the icon to watch the video for this section :

Adjustable lights

The "Light controls" page described above allows you to add 
"adjustable" lights. As an example, you can add 2 lights. You 
can do so in three different ways :

    • Click in the box containing the number "0" next to 
"Number of adjustable lights" and type in "2"

    • Click on the triangle to the right of the number "0". Click 
and drag the triangle to the right until you see the num-
ber "2"

    • Click on the horizontal line to the right of the triangle 
and click twice to increase the number to "2".

When you have done, the window is as follows :
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Technical view of 
the adjustable 
light page

After entering the number of lights, click "Next" to open the 
"Technical View" page. This page offers three options:

    • View the elements as a simple set of buttons (in this ca-
se you can also select the background colour)

    • View the elements against a background image (in this 
case you can select a background image)

    • You can also give the page a title by editing the "Title" 
field

If you select "View the elements as a simple set of buttons", 
you can select a background colour by clicking the white box 
"Select background colour" , the window is now as follows :

If you select the "View the elements against a background 
image", the window is as follows :
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On the same page, you can select a background image by cli-
cking the blue rectangle "Select background image": 
                                       

At this point, clicking "Done" will not select any image. The 
objects on the page are automatically shown against a light 
blue background where you can edit them as required.
If instead you wish to set a background image, select the re-
quired image and click "Done".
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You can now change the name of the page (in the example, to 
"Lights 002"). Click "Next" :

Appearance of 
the adjustable 
lights

This page, called "Appearance of the adjustable lights", allows 
you to edit the following properties : 

    • Images
    • Button text
    • Options
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Images

The "Images" area has two options :

    • Skin
    • Images

If you select "Skin" and click the drop-down menu, you can 
then choose between these options :

If you select "Images" you can select an image to be assigned 
to the button :

On the next page you can select the image you wish to use :
- User Manual - rev. 2.0



Chapter 4

Project Management

81
Select the required image and click "Done".

Button text

This option allows you to attribute text to the button.
Select the "Display text on selected button" checkbox in the 
"Button text" area. You can now edit these parameters:

    • Colour
    • Size
    • Alignment

Click in the box next to "Colour" to select the colour of the text 
:
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Click in the rectangles next to "Size" to select the size of the 
text :

Click in the rectangles next to "Alignment" to select where to 
put the text, at the centre, to the left or to the right :
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Options

The "Options" window allows you to determine whether the 
buttons are read-only or configurable. 
A "read" button cannot be assigned variables, while a "read-
and-write" one can.
The default image is :

The option "Read and write buttons" offers two choices :

    • "Open the intensity adjustment popup window" (a pop-
up bar appears that allows you to adjust the intensity of 
the light) :
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    • "Show the increase and decrease buttons". In this case 
you can display the "increase and decrease" buttons on 
the left or on the right :

Technical View of 
the adjustable 
light objects

Click "Next" to open the "Technical View" page that displays 
all the objects concerned :

Click the blue button above "Objects" in the top left-hand cor-
ner of the page. A tree menu opens where you can select the 
technical view of the buttons created :
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On the same page, click the blue button above "Properties" in 
the top right-hand corner. A tree menu opens allowing you to 
view the properties of the button selected in the left-hand me-
nu (Objects) :

You can also modify the position of the button on the page 
using the X and Y variables, and edit the width and height of 
the button using the W and H variables.
You can edit the values in the same 3 ways described earlier 
on :

    • Click in the box containing the number next to the va-
riable you wish to edit, and type in the required num-
ber

    • Click on the triangle to the right of the box. Click and 
drag the triangle to the right until you see the required 
number

    • Click on the horizontal line to the right (or left) of the 
triangle and keep clicking until you see the required 
number

You can also use the + and - buttons at the bottom of the page 
to zoom in and out of the page.
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If you wish to move a button, you can use the mouse by pla-
cing the cursor on the button, clicking and dragging it to the 
required place on the page.
Double-clicking on an object opens a page where you can edit 
its properties :

Configuring the 
adjustable light 
variables

On the "Technical View" page, click "Next" to open the "Varia-
ble configuration" page :
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You will notice the objects on the page are pink in colour. This 
means they have not yet been assigned a variable. The first 
thing to do, therefore, is to create a variable (see chapter 4, 
“Creating a new variable” page 53).
Create the variable (in the example, "on/off light 1"). Select it 
with the mouse and drag it onto the selected button : 

The button changes colour. The pink image disappears. You 
can move the cursor over the button to view the properties of 
the assigned variable :
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Follow the same procedure to assign variables to the other 
buttons, after of course having created the variables concer-
ned (see chapter 4, “Creating a new variable” page 53).
On the "Variable configuration" page, you can view the objects 
in 2 different ways :

    • Page mode (by clicking the respective button) :

    • List mode (by clicking the respective button) :
- User Manual - rev. 2.0



Chapter 4

Project Management

89
The properties of the objects can be edited in both cases (mo-
difying the reading/writing status by assigning different varia-
bles, managing variables, creating and eliminating variables, 
modifying the "on" and "off" values).

After entering all the data on the "Variable configuration" pa-
ge, click "Done" to return to the MyVision main page.

Click on the icon to watch the video for this section :
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Creating a 
"HVAC" page

Start by clicking the "New page wizard" button :

On the next page, use the mouse to select the "HVAC" icon :

You will see :
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MyVision offers these options :

    • Ventilation
    • Heating / Cooling

The ventilation option allows you to manage up to 10 points 
for each page of the project created. 1 or 2 speeds can be set 
for each ventilation point.
The heating/cooling option allows you to manage up to 10 
points for each page of the project created. A minimum and 
maximum temperature can be set for each cooling/heating 
point, in degrees centigrade. These can be between 0 and 
40°C. They are set by default at 15°C (minimum value) and 
30°C (maximum value).
As an example, you can set 2 x ventilation points at 2 speeds 
and 2 x heating points at the default min and max values (15 
and 30°C).
The temperature settings and number of speeds for the ven-
tilation and heating/cooling points respectively can be confi-
gured in 3 different ways :

    • Click in the box containing the number "0" next to 
"Number of ventilation points" and type in "2"

    • Click on the triangle to the right of the number "0". Click 
and drag the triangle to the right until you see the num-
ber "2"

    • Click on the horizontal line to the right of the triangle 
and click twice. The number in the box increases to "2"
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Repeat the same procedure for the "Cooling/heating points" 
and temperature settings. When you have done, the window 
is as follows :

Technical view of 
the HVAC page

Click "Next" to see the following :

If you select "View the elements as a simple set of buttons", 
you can select a background colour by clicking the white box 
"Select background colour" . The window is now as follows:
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If you select the "View the elements against a background 
image", the window is as follows :

On the same page, you can select a background image by cli-
cking the blue rectangle "Select background image" : 
                                      
                            
 

MyVision - User Manual - rev. 2.0



Chapter 4

Project Management 

94

MyVision 
At this point, clicking "Done" will not select any image. The 
objects on the page are automatically shown against a light 
blue background where you can edit them as required.
If instead you wish to set a background image, select the re-
quired image and click "Done" :

You can now change the name of the page (in the example, to 
"HVAC 001"). Click "Next" :
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Appearance of 
ventilation

This page, called "Appearance of ventilation", offers these op-
tions :

    • Images
    • Button text
    • Options

Images

The "Images" area has two options :

    • Skin
    • Images

If you select "Skin" and click the drop-down menu, you can 
then choose between these options :
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Selecting the "Images" option and clicking one of the three fan 
symbols (off, on at speed 1, on at speed 2) :

Opens this page where you can select which image to use:

Select the required image and click "Done".
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Button text

This option allows you to attribute text to the button.
Select the "Display text on selected button" checkbox in the 
"Button text" area. You can now edit these parameters :

    • Colour
    • Size
    • Alignment

Click in the box next to "Colour" to select the colour of the 
text:

Click in the rectangles next to "Size" to select the size of the 
text :
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Click in the rectangles next to "Alignment" to select where to 
put the text, at the centre, to the left or to the right :

Options

The "Options" window allows you to determine whether the 
buttons are read-only or configurable. 
A "read" button cannot be assigned variables, while a "read-
and-write" one can.
The default image is :
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The option "Read and write buttons" offers three choices :

    • "Open the ventilation adjustment popup window" (a 
pop-up bar appears that allows you to adjust the inten-
sity of the ventilation) :

    • "Revert mode": this option allows you to change the 
mode at each press of the button. For instance, if the 
button is assigned ventilation at a single speed, pres-
sing it the first time will turn the fan ON from standstill, 
and pressing it again will turn the fan OFF again.

    • "Show the increase and decrease buttons". In this case 
you can display the "increase and decrease" buttons on 
the left or on the right of the button used for the 
project:

Appearance of 
heating / cooling

After configuring the "Appearance of ventilation" page, click 
"Next" to open the page called "Appearance of heating/coo-
ling" and edit the following :

    • Button text
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    • Type of button
    • Temperature text

Button text

This option allows you to add or remove text from a button.

Select the "Display text on the selected button" checkbox in 
the "Button text" area. You can then modify the following pa-
rameters:

    • Colour
    • Size
    • Alignment

Click in the box next to "Colour" to select the colour of the 
text:
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Click in the rectangles next to "Size" to select the size of the 
text :

Click in the rectangles next to "Alignment" to select where to 
put the text, at the centre, to the left or to the right:
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Temperature text

This option is for the temperature indicator (enabled by de-
fault on the "Appearance of heating/cooling" page. It allows 
you to determine the colour of the text indicating the tempe-
rature value.
The window is by default the following :

Click in the box next to "Text colour" to select the colour for 
indicating the temperature :
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If for instance you wish to choose red, the temperature is 
shown as follows :

Type of button

This option offers two possibilities :

    • Show temperature adjustment
    • Show a temperature indicator

Selecting the "Show temperature adjustment" option opens 
the "Image" window where you can choose a "Skin" or "Ima-
ge" for the button :

Selecting the "Show a temperature indicator" option allows 
you to display the control buttons on the left or on the right :

The "Temperature text" window, described above, also appe-
ars.
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Technical view of 
HVAC objects

Click "Next" to open the "Technical View" page that displays 
all the objects concerned :

Click the blue button above "Objects" in the top left-hand cor-
ner of the page. A tree menu opens where you can select the 
technical view of the buttons created (in the example, note 
that the first 2 buttons are for ventilation while buttons 3 and 
4 are for heating/cooling) :

On the same page, click the blue button above "Properties" in 
the top right-hand corner. A tree menu opens allowing you to 
view the properties of the button selected in the left-hand me-
nu (Objects) :
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You can also use the + and - buttons at the bottom of the page 
to zoom in or out of the page :

Configuration of 
HVAC variables

On the previous page, click "Next" to open the "Variable con-
figuration" page :
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You will notice the objects on the page are pink in colour. This 
means they have not yet been assigned a variable. The first 
thing to do, therefore, is to create a variable (see chapter 4, 
“Creating a new variable” page 53).
After creating the variable (in the example, called 
"on_off_fan_1"), use the mouse to select it and drag it onto 
the selected button :
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The button changes colour. The pink image disappears. You 
can move the cursor over the button to view the properties of 
the assigned variable :

Follow the same procedure to assign variables to the other 
buttons, after of course having created the variables concer-
ned (see chapter 4, “Creating a new variable” page 53).
On the "Variable configuration" page, you can view the objects 
in 2 different ways :

    • Page mode (by clicking the respective button) :

    • List mode (by clicking the respective button) :
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The properties of the objects can be edited in both cases (mo-
difying the reading/writing status by assigning different varia-
bles, managing variables, creating and eliminating variables, 
modifying the "on" and "off" values).

After entering all the data on the "Variable configuration" pa-
ge, click "Done" to return to the MyVision main page.

Click on the icon to watch the video for this section :

Creating an 
"Irrigation" 
page

Start by clicking the "New page wizard" button (see chapter 4, 
“Creating a new page” page 51).
On the next page, use the mouse to select the "Irrigation" 
icon:
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You will see :

It is possible to have 1 to 20 irrigation areas for each page cre-
ated. If you start with 1 irrigation point and wish to increase 
this number, there are 3 ways of doing so :

    • Click in the box containing the number "1" next to 
"Number of irrigation areas" and type in the required 
number

    • Click on the triangle to the right of the number "1". Click 
and drag the triangle to the right until you see the re-
quired number
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    • Click on the horizontal line to the right of the triangle 
and keep clicking until you see the required number.

Click "Next" to open the next page :

Technical view of 
Irrigation page

The "Technical View" page offers these options :

    • View the elements as a simple set of buttons (in this ca-
se you can also select the background colour)

    • View the elements against a background image (in this 
case you can select a background image)

    • You can also give the page a title by editing the "Title" 
field

If you select "View the elements as a simple set of buttons", 
you can select a background colour by clicking the white box 
"Select background colour" . The window is now as follows:
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If you select the "View the elements against a background 
image", the window is as follows :

On the same page, you can select a background image by cli-
cking the blue rectangle "Select background image" :
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At this point, clicking "Done" will not select any image. The 
objects on the page are automatically shown against a light 
blue background where you can edit them as required.
If instead you wish to set a background image, select the re-
quired image and click "Done" :

On the next page you can, if you like, change the name of the 
page (for example, "Water 001") and click "Next" :
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Appearance of 
Irrigation

This page, "Appearance of Irrigation", allows you to edit these 
properties :

    • Images
    • Button text
    • Options

Images

The "Images" area has two options :

    • Skin
    • Images

If you select "Skin" and click the drop-down menu, you can 
then choose between these options :
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If you select "Images" you can select an image to be assigned 
to the button :

On the next page you can select the image you wish to use :
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Select the required image and click "Done".

Button text

This option allows you to attribute text to the button.
Select the "Display text on selected button" checkbox in the 
"Button text" area. You can now edit these parameters :

    • Colour
    • Size
    • Alignment

Click in the box next to "Colour" to select the colour of the 
text:
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Click in the rectangles next to "Size" to select the size of the 
text :

Click in the rectangles next to "Alignment" to select where to 
put the text, at the centre, to the left or to the right :
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Options

The "Options" window allows you to determine whether the 
buttons are read-only or configurable. 
A "read" button cannot be assigned variables, while a "read-
and-write" one can.
The default image is :

Technical view of 
Irrigation objects

Click "Next" to open the "Technical View" page that displays 
all the objects concerned :
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Click the blue button above "Objects" in the top left-hand cor-
ner of the page. A tree menu opens where you can select the 
technical view of the buttons created :

On the same page, click the blue button above "Properties" in 
the top right-hand corner. A tree menu opens allowing you to 
view the properties of the button selected in the left-hand me-
nu (Objects) :
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You can also modify the position of the button on the page 
using the X and Y variables, and edit the width and height of 
the button using the W and H variables.
You can edit the values in the same 3 ways described earlier 
on :

    • Click in the box containing the number next to the va-
riable you wish to edit, and type in the required number

    • Click on the triangle to the right of the box. Click and 
drag the triangle to the right until you see the required 
number

    • Click on the horizontal line to the right (or left) of the 
triangle and keep clicking until you see the required 
number.

You can also use the + and - buttons at the bottom of the page 
to zoom in or out of the page :

If you wish to move a button, you can use the mouse by pla-
cing the cursor on the button, clicking and dragging it to the 
required place on the page.
Double-clicking on an object opens a page where you can edit 
its properties :
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Configuration of 
Irrigation 
Variables

On the "Technical View" page, click "Next" to open the "Varia-
ble configuration" page :

You will notice the objects on the page are pink in colour. This 
means they have not yet been assigned a variable. The first 
thing to do, therefore, is to create a variable (see chapter 4, 
“Creating a new variable” page 53).
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After creating the variable (in the example, called "Irriga-
tion"), use the mouse to select it and drag it onto the selected 
button :

The button changes colour. The pink image disappears. You 
can move the cursor over the button to view the properties of 
the assigned variable :

Follow the same procedure to assign variables to the other 
buttons, after of course having created the variables concer-
ned (see chapter 4, “Creating a new variable” page 53).
On the "Variable configuration" page, you can view the objects 
in 2 different ways :

    • Page mode (by clicking the respective button) :
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    • List mode (by clicking the respective button) :

The properties of the objects can be edited in both cases (mo-
difying the reading/writing status by assigning different varia-
bles, managing variables, creating and eliminating variables, 
modifying the "on" and "off" values).

After entering all the data on the "Variable configuration" pa-
ge, click "Done" to return to the MyVision main page.

Click on the icon to watch the video for this section :

Creating a 
Scenario page

A "Scenario" is a specific situation to be executed in a room of 
a home or hotel.
A scenario can be executed using one or more complex factors 
such as "access control", "video-surveillance", "alarms", "air 
conditioning", etc. In the interest of clarity, we will create a 
simple "night scenario" when the lights are turned off.
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A scenario can be created when a project page already exists, 
for example, a "on/off lights" page, (see chapter 4, “Creating 
a Lights page” page 62).
To create a new "scenario" page, go to the MyVision main pa-
ge by clicking the icon :

This page opens :

Open the "Wizard" to create a new page, following the arrow :
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Click the "Scenarios" button :

Scenario 
Manager

Open the "Scenario manager" page :

Technical view of 
Scenario page

Click "Next" to open the "Technical View" page. There are the-
se options :

    • View the elements as a simple set of buttons (in this ca-
se you can also select the background colour)

    • View the elements against a background image (in this 
case you can select a background image)

    • You can also give the page a title by editing the "Title" 
field
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If you select "View the elements as a simple set of buttons", 
you can select a background colour by clicking the white box 
"Select background colour" . The window is now as follows:

If you select the "View the elements against a background 
image", the window is as follows :
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On the same page, you can select a background image by cli-
cking the blue rectangle "Select background image" :
                                      

At this point, clicking "Done" will not select any image. The 
objects on the page are automatically shown against a light 
blue background where you can edit them as required.
If instead you wish to have a background image on the page, 
select the required image and then click "Done" :
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You can now change the name of the page (for example, "Sce-
nario 001") and click "Next" :

The "Scenario manager" page shows all the scenarios for the 
project. You can also create new ones. In this case, no scena-
rios have yet been created. You can create a new one by cli-
cking the "Add" button in the bottom left-hand corner :
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This window appears where you can assign a name to the sce-
nario and add a description, if necessary :

For example, the new scenario can be called "Night" :

Click "OK" to open this window :
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Appearance of 
Scenario 
Buttons

This page, called "Appearance of Scenario Buttons", allows 
you to edit the following properties :

    • Images
    • Button text
    • Options

Images

The "Images" area has two options :

    • Skin
    • Images

If you select "Skin" and click the drop-down menu, you can 
then choose between these options :

If you select "Images" you can select an image to be assigned 
to the button :

On the next page you can select the image you wish to use :
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Select the required image and click "Done" :

Button text

This option allows you to attribute text to the button.
Select the "Display text on selected button" checkbox in the 
"Button text" area. You can now edit these parameters :

    • Colour
    • Size
    • Alignment
- User Manual - rev. 2.0



Chapter 4

Project Management

131
Click in the box next to "Colour" to select the colour of the 
text:

Click in the rectangles next to "Size" to select the size of the 
text :
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Click in the rectangles next to "Alignment" to select where to 
put the text, at the centre, to the left or to the right :

Options

The "Options" window allows you to determine whether the 
buttons are read-only or configurable. 
A "read" button cannot be assigned variables, while a "read-
and-write" one can.
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The default image is :

Technical View of 
Scenario objects

Click "Next" to open the "Technical View" page that displays 
all the objects concerned :

Click the blue button above "Objects" in the top left-hand cor-
ner of the page. A tree menu opens where you can select the 
technical view of the buttons created :

On the same page, click the blue button above "Properties" in 
the top right-hand corner. A tree menu opens allowing you to 
view the properties of the button selected in the left-hand me-
nu (Objects) :
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You can also modify the position of the button on the page 
using the X and Y variables, and edit the width and height of 
the button using the W and H variables.
You can edit the values in the same 3 ways described earlier 
on :

    • Click in the box containing the number next to the va-
riable you wish to edit, and type in the required number

    • Click on the triangle to the right of the box. Click and 
drag the triangle to the right until you see the required 
number

    • Click on the horizontal line to the right (or left) of the 
triangle and keep clicking until you see the required 
number

You can also use the + and - buttons at the bottom of the page 
to zoom in or out of the page :
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If you wish to move a button, you can use the mouse by pla-
cing the cursor on the button, clicking and dragging it to the 
required place on the page.
Double-clicking on an object opens a page where you can edit 
its properties :

On the "Technical View" page, click "Done" to return to the 
MyVision main page :

Click on the icon to watch the video for this section :
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Scenario 
management

Once you have created a scenario, return to the MyVision 
main page where you can access the "Device scenario mana-
gement" in two ways :

1) On the "Device" menu, click "Device scenario manage-
ment":

2) On the main icon bar, click the "Device scenario manage-
ment" icon :

Either way, you open this page :
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Note the large green arrow indicating the next action.

Project 
scenario 
window

The "Project scenario management" page features a window 
to the left called "Project scenarios" that lists the project sce-
narios.
There are 4 icons at the bottom of this window that allow you 
to create new scenarios, delete one or more scenarios, or im-
port and export scenarios (in the latter two cases, the files ha-
ve to be in .xls format). The icons are shown below :

You can also create and delete a scenario in the window by ri-
ght-clicking its name :
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In this case, select a "initial scenario" and a "final scenario" by 
opening the drop-down menu of the first and then the next op-
tion
For example, you can choose "onoff_1_on" as the initial sce-
nario, "onoff_1_off" as the final scenario and "Every day" as 
the type, selecting the required option in the drop-down me-
nu:

You can now configure the start times for the initial and final 
scenarios by clicking the triangles under the horizontal line :

There are 2 ways of setting the times :

    • Click the triangle and drag it onto the left to set an ear-
lier start time, or to the right for a later one

    • Click the horizontal line to the left of the triangle (each 
click of the mouse decreases the tim by 15 minutes) or 
to the right of the triangle (each click of the mouse in-
creases the time by 15 minutes)

In the example, the start time of the first scenario (the initial 
scenario) is set at 7:30, while the start time of the second sce-
nario (the final scenario) is set at 17:30.
A light assigned to the initial scenario (onoff_1_on) turns on 
at 7:30 and remains ON until the start of the final scenario 
(17:30), when the "onoff_1_off" scenario commences (in 
practice, the light remains OFF until 7:30 the following day 
when the initial scenario starts again :
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Project data 
window

The "Project scenario management" page features a window 
to the right called "project data" with a graphical representa-
tion of the project and its elements (floors, areas, rooms, de-
vices and network points).
The "project data" window, like the MyVision main page (to be 
discussed later on, see chapter 4, “Editing the project compo-
nents” page 224) allows you to edit all the components of the 
project. For example :

    • Add a new floor (see chapter 4, “Editing the project 
components” page 224)

    • Add a new area (see chapter 4, “Editing the project 
components” page 224)

    • Add a new room (see chapter 4, “Editing the project 
components” page 224)

    • Add a new device (see chapter 4, “Editing the project 
components” page 224)

    • Add a new network point (see chapter 4, “Editing the 
project components” page 224)

Creating a new 
Scheduler

The "Scheduler" allows you to manage various activities or 
scenarios within a certain timeframe (usually 24 hours). Acti-
vities can be scheduled for all days of the week or just for cer-
tain days (such as week-ends).
To create a "scheduler" you need to first create one or more 
"scenarios" (see chapter 4, “Creating a Scenario page” 
page 122).
There are two ways of creating a new "scheduler" :

1) On the "Device" menu, click "Device scheduler manage-
ment" :
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2) Click the "Device scheduler management" icon at the top, 
on the main icon bar :

The window is as follows :
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Taking the green arrow into account, click the "Create a new 
Scheduler" icon in the bottom left-hand corner :

You can now assign the Scheduler a name and description :

In the example, the Scheduler is named "sc_onoff1". Click OK 
to continue :

Note that the new Scheduler has appeared in the top left-hand 
corner of the window, under the name of the ESA device :
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Click on the icon to watch the video for this section :

Scheduler 
management

The window above allows you to assign the Scheduler to an 
existing "scenario" (see chapter 4, “Creating a Scenario page” 
page 122) or "chrono-thermostat".
In the example, the Scheduler is assigned to a scenario by 
opening the "Type" drop-down menu :
 

Select an "initial scenario" and a "final scenario" by opening 
the drop-down menu of the first and then the next scenario :
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For example, you can choose "onoff_1_on" as the initial sce-
nario, "onoff_1_off" as the final scenario and "Every day" as 
the type, selecting the required option in the drop-down me-
nu:

You can now configure the start times for the initial and final 
scenarios by clicking the triangles under the horizontal line :

There are 2 ways of setting the times :

    • Click the triangle and drag it onto the left to set an ear-
lier start time, or to the right for a later one.

    • Click the horizontal line to the left of the triangle (each 
click of the mouse decreases the time by 15 minutes) or 
to the right of the triangle (each click of the mouse in-
creases the time by 15 minutes).
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In the example, the start time of the first scenario (the initial 
scenario) is set at 7:30, while the start time of the second sce-
nario (the final scenario) is set at 17:30.
A light assigned to the initial scenario (onoff_1_on) turns on 
at 7:30 and remains ON until the start of the final scenario 
(17:30), when the "onoff_1_off" scenario commences (in 
practice, the light remains OFF until 7:30 the following day 
when the initial scenario starts again:

Click on the icon to watch the video for this section:

Deleting a 
Scheduler

The "Device scheduler management" page allows you to dele-
te one or more schedulers.
Select the Scheduler you wish to delete :
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Click the "Delete Scheduler" icon in the bottom left-hand cor-
ner :

This window opens :

Click "Yes" to confirm you wish to delete the selected Schedu-
ler.

Click on the icon to watch the video for this section :

Creating a 
Hotel room 
page

The "hotel room" page allows you to manage the following 
objects simultaneously :

    • ON/OFF lights
    • Adjustable lights
    • Ventilation points
    • Heating/cooling points
    • Rolling shutters
    • Curtains
    • Windows
    • "Do not disturb" button
    • "Room service" button

To create a "hotel room" page, use the "New page wizard" 
(see chapter 4, “Creating a new page” page 51).
On the next page, click the "hotel room" icon :
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This window then appears. You can now set the number of ON/
OFF lights and the number of adjustable lights you wish to 
control in the room (see chapter 4, “Creating a Lights page” 
page 62) :

Once you have configured the "Lights" page, click "Next" to 
configure the "Ventilation and cooling" page (see chapter 4, 
“Creating a "HVAC" page” page 90) :
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Once you have configured the "Ventilation and cooling" page, 
click "Next" to configure the "Rolling shutters, Curtains and 
Windows" page (see chapter 4, “Creating a Windows page” 
page 176) :

Once you have configured the "Rolling shutters, Curtains and 
Windows" page, click "Next" to configure the "Other buttons" 
page (for the "Do not disturb" and "Room service" buttons) :
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Select the two checkboxes and the "Do not disturb" and 
"Room service" buttons are shown on the page being created :

Technical View of 
the Hotel room 
page 

Click "Next" to open the "Technical View" page. There are the-
se options :

    • View the elements as a simple set of buttons (in this ca-
se you can also select the background colour)

    • View the elements against a background image (in this 
case you can select a background image)

    • You can also give the page a title by editing the "Title" 
field
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If you select "View the elements as a simple set of buttons", 
you can select a background colour by clicking the white box 
"Select background colour"  the window is now as follows  :

Select the "Show the elements against a background image" 
option and click the blue rectangle marked "Select background 
image". You will see :
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At this point, clicking "Done" will not select any image. The 
objects on the page are automatically shown against a light 
blue background where you can edit them as required.
If instead you wish to have a background image on the page, 
select the required image and then click "Done" :

You can now change the name of the page (for example, "Ho-
tel Room 001") and click "Next" :
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Click on the icon to watch the video for this section :

Appearance of 
buttons on 
Hotel Room 
page

The page, called "Appearance of buttons on Hotel Room pa-
ge", allows you to edit the various types of buttons you have 
added. For example, if you have added all the available op-
tions, you will have an "Appearance" page for each option 
used :

    • ON/OFF lights (see chapter 4, “Appearance of the ON/
OFF lights” page 67)

    • Adjustable lights (see chapter 4, “Appearance of the 
adjustable lights” page 79)

    • Ventilation points (see chapter 4, “Appearance of venti-
lation” page 95)

    • Heating/cooling points (see chapter 4, “Appearance of 
heating / cooling” page 99)

    • Rolling shutters (see chapter 4, “Appearance of Rolling 
shutter Buttons” page 182)

    • Curtains (see chapter 4, “Appearance of Curtain But-
tons” page 187)

    • Windows  (see chapter 4, “Appearance of Window But-
tons” page 190)

    • "Do not disturb" button
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    • "Room service" button

After editing the appearance of all the above buttons, you ne-
ed to edit the appearance of the "Other buttons" (the "Do not 
disturb" and "Room service" buttons). You can edit these pro-
perties :

    • Images
    • Button text
    • Options

Images

The "Images" area has two options :

    • Skin
    • Images

If you select "Skin" and click the drop-down menu, you can 
then choose between these options :

If you select "Images" you can select an image to be assigned 
to the button:
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On the next page you can select the image you wish to use:

Select the required image and click "Done" :

Button text

This option allows you to attribute text to the button.
Select the "Display text on selected button" checkbox in the 
"Button text" area. You can now edit these parameters :

    • Colour
    • Size
    • Alignment
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Click in the box next to "Colour" to select the colour of the 
text:

Click in the rectangles next to "Size" to select the size of the 
text :
- User Manual - rev. 2.0



Chapter 4

Project Management

155
Click in the rectangles next to "Alignment" to select where to 
put the text, at the centre, to the left or to the right :

Options

The "Options" window allows you to determine whether the 
buttons are read-only or configurable. 
A "read" button cannot be assigned variables, while a "read-
and-write" one can.
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The default image is :

Click on the icon to watch the video for this section :

Technical view of 
Hotel room 
objects

Click "Next" to open the "Technical View" page that displays 
all the objects concerned :

Click the blue button above "Objects" in the top left-hand cor-
ner of the page. A tree menu opens where you can select the 
technical view of the buttons created :
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On the same page, click the blue button above "Properties" in 
the top right-hand corner. A tree menu opens allowing you to 
view the properties of the button selected in the left-hand me-
nu (Objects) :

You can also modify the position of the button on the page 
using the X and Y variables, and edit the width and height of 
the button using the W and H variables.
You can edit the values in the same 3 ways described earlier 
on :
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    • Click in the box containing the number next to the va-
riable you wish to edit, and type in the required num-
ber

    • Click on the triangle to the right of the box. Click and 
drag the triangle to the right until you see the required 
number

    • Click on the horizontal line to the right (or left) of the 
triangle and keep clicking until you see the required 
number

You can also use the + and - buttons at the bottom of the page 
to zoom in or out of the page :

If you wish to move a button, you can use the mouse by pla-
cing the cursor on the button, clicking and dragging it to the 
required place on the page :
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Double-clicking on an object opens a page where you can edit 
its properties :

Configuring the 
Hotel room 
variables

On the "Technical View" page, click "Next" to open the "Varia-
ble configuration" page :
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You will notice the objects on the page are pink in colour. This 
means they have not yet been assigned a variable. The first 
thing to do, therefore, is to create a variable (see chapter 4, 
“Creating a new variable” page 53).
Once you have created the variable, select it with the mouse 
and drag it onto the selected button : 

The "Do not disturb" button changes colour. The pink image 
disappears. You can move the cursor over the button to view 
the properties of the assigned variable :

Follow the same procedure to assign variables to the other 
buttons, after of course having created the variables concer-
ned (see chapter 4, “Creating a new variable” page 53).
On the "Variable configuration" page, you can view the objects 
in 2 different ways :

    • Page mode (by clicking the respective button) :
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    • List mode (by clicking the respective button) :

The parameters of the objects can be edited in both cases 
(modifying the reading/writing status by assigning different 
variables, managing variables, creating and eliminating varia-
bles, modifying the "on" and "off" values and editing all the 
other parameters of the objects).

After entering all the data on the "Variable configuration" pa-
ge, click "Done" to return to the MyVision main page.
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Click on the icon to watch the video for this section :

Device alarm 
management

There are two ways of opening the "Device alarm manage-
ment" page :

    • Click the "Device" menu on the main menu bar and se-
lect "Device alarm management" (see chapter 3, “Devi-
ce Menu” page 14)

    • Click the "Device alarm management" icon :

This window opens. Look at the green arrow. Enter a new 
"Alarm set" by clicking the icon in the bottom left-hand cor-
ner:

This window opens where you can name the alarm set you ha-
ve just created :
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Click "OK". This window opens :

You can create and/or remove, import or export one or more 
"alarm categories" by clicking the icons at the bottom of the 
window :

Creating a new 
alarm

After creating an "alarm set" you can add a new alarm by cli-
cking the "Add" button at the bottom of the page :
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Alternatively you can click the "Alarm" button. The result is 
the same :

Next, click the "Create a new alarm" icon :

You can create and/or remove, import or export one or more 
"alarms" by clicking the respective icons :

This window opens. You can now name the alarm you have 
just created :

Click OK. This window opens :
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Editing an 
alarm

You can edit the alarm you have just created by clicking the 
"Detail" icon:

This window opens:
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You can edit these features of the alarm by clicking the res-
pective fields :

    • Associated set
    • Associated variable
    • Value
    • Priority
    • Intended page

You can also select the respective checkbox to determine 
whether :

    • The alarm is of the type "ISA" (the "ISA-1A" standard 
requires the alarm signal to persist until the operator 
acknowledges -stops- it).

    • To display the alarm
    • To save the alarm

Associated set

Open the drop-down menu. Select the set for the new alarm. 
In the example, the alarm is associated with set 1 (as this is 
the only set created so far) :

Associated variable

Open the drop-down menu. Associate the alarm to one of the 
variables :

Select the required variable and click OK: 
- User Manual - rev. 2.0



Chapter 4

Project Management

167
Value

By entering "20" in the "Value" field, the alarm is activated 
when the variable reaches value "20". For example, if the 
alarm is associated to a temperature variable, the alarm is di-
splayed when the temperature reaches 20°C :

Priority

There are three priority levels for the alarm :

    • Information
    • Warning
    • Error
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In practice, the three alarm priorities are classified according 
to the importance of the same alarm :

1) Relatively important alarm (Information)
2) Moderately important alarm (Warning)
3) Very important alarm (Error)

Intended page

When an alarm occurs, you can click the drop-down menu to 
select which page to open :

Click on the icon to watch the video for this section :
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Creating an 
Alarm page

Start by clicking the text "New page Wizard":

A new page opens. Use the mouse to select the "Alarm" icon :

In the next window, choose the columns to be shown in the 
table on the alarm page by selecting the respective checkbox. 
You can also change the heading of each column in the table 
by editing the respective field :
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The "Set", "Alarm date" and "Recognition date" are unselected 
by default. If you wish to create a table with all the possible 
options, select all the checkboxes and you will get a table with 
these columns :

    • Alarm name
    • Description
    • Set
    • Recognition
    • Status
    • Alarm date
    • Recognition date

The window is as follows. Click "Next" :
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Alarm page 
configuration

The page is called "Alarm page configuration" and has the fol-
lowing sections :

    • Page title
    • Page properties
    • Alarm table
    • Display the following buttons

Page title

The "Page title" option allows you to name the alarm page you 
are creating by editing the "Title" field :

Page properties

The "Page properties" offers the following options:

    • View the elements as a simple grid (in this case you can 
also select the background colour)
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    • View the elements against a background image (in this 
case you can select a background image)

If you select "View the elements as a simple grid", you can se-
lect a background colour by clicking the white box "Select 
background colour"  the window is now as follows :

If you select the "View the elements against a background 
image", the window is as follows :
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On the same page, you can select a background image by cli-
cking the blue rectangle "Select background image" :
                                       

At this point, clicking "Done" will not select any image. The 
objects on the page are automatically shown against a light 
blue background.
If instead you wish to have a background image, select the re-
quired image and then click "Done":
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Technical view of 
Alarm page 
objects

Click "Next" to open the "Technical View" page that displays 
all the objects concerned :

Click the blue button above "Objects" in the top left-hand cor-
ner of the page. A tree menu opens where you can select the 
technical view of the buttons created :
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On the same page, click the blue button above "Properties" in 
the top right-hand corner. A tree menu opens allowing you to 
view the properties of the button selected in the left-hand me-
nu (Objects) :

You can also modify the position of the button on the page 
using the X and Y variables, and edit the width and height of 
the button using the W and H variables.
You can edit the values in the same 3 ways described earlier 
on :

    • Click in the box containing the number next to the va-
riable you wish to edit, and type in the required number

    • Click on the triangle to the right of the box. Click and 
drag the triangle to the right until you see the required 
number

    • Click on the horizontal line to the right (or left) of the 
triangle and keep clicking until you see the required 
number

You can also use the + and - buttons at the bottom of the page 
to zoom in or out of the page :
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If you wish to move a button, you can use the mouse by pla-
cing the cursor on the button, clicking and dragging it to the 
required place on the page

Double-clicking on an object opens a page where you can edit 
its properties

Click on the icon to watch the video for this section :

Creating a 
Windows page

The "Windows" page allows you to manage the following 
objects simultaneously :

    • Rolling shutters
    • Curtains
    • Windows

To create a "Windows" page, use the "New page wizard" (see 
chapter 4, “Creating a new page” page 51).

On the next page, click the "Windows" icon :
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You will see :

Rolling shutters The "Number of Rolling shutters" option allows you to manage 
up to 10 objects (rolling shutters) for each page you have cre-
ated. Each rolling shutter can be assigned 0, 1 or 2 "Interme-
diate steps" :

    • "0" Intermediate steps: fully lowered or fully raised rol-
ling shutter

    • "1" Intermediate step: fully lowered, half-raised or fully 
raised rolling shutter

    • "2" Intermediate steps: fully lowered, 1/3 open, 2/3 
open or fully raised rolling shutter

You can edit the number of rolling shutters in the same three 
ways described previously :

    • Click in the box containing the number next to "Number 
of rolling shutters" and type in the required number

    • Click on the triangle to the right of the box. Click and 
drag the triangle to the right until you see the required 
number

    • Click on the horizontal line to the right (or left) of the 
triangle and keep clicking until you see the required 
number

If for instance you wish to add one rolling shutter with one in-
termediate step, you will see :
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Curtains The "Number of curtains" option allows you to manage up to 
10 objects (curtains) for each page you have created. 
You can edit the number of rolling curtains in the same three 
ways described previously :

    • Click in the box containing the number next to "Number 
of curtains" and type in the required number

    • Click on the triangle to the right of the box. Click and 
drag the triangle to the right until you see the required 
number

    • Click on the horizontal line to the right (or left) of the 
triangle and keep clicking until you see the required 
number

If for instance you wish to add one curtain, you will see :

Windows The "Number of Windows" option allows you to manage up to 
10 objects (windows) for each page you have created.
You can edit the number of windows in the same three ways 
described previously:

    • Click in the box containing the number next to "Number 
of windows" and type in the required number

    • Click on the triangle to the right of the box. Click and 
drag the triangle to the right until you see the required 
number

    • Click on the horizontal line to the right (or left) of the 
triangle and keep clicking until you see the required 
number

If for instance you wish to add one window, you will see :
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Technical view 
of Windows 
page

When you have done, click "Next". This window appears (Te-
chnical View). You can choose between these options :

    • View the elements as a simple set of buttons (in this ca-
se you can also select the background colour)

    • View the elements against a background image (in this 
case you can select a background image)

    • You can also give the page a title by editing the "Title" 
field

If you select "View the elements as a simple set of buttons", 
you can select a background colour by clicking the white box 
"Select background colour"  the window is now as follows :
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If you select the "View the elements against a background 
image", the window is as follows :

On the same page, you can select a background image by cli-
cking the blue rectangle "Select background image" :
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At this point, clicking "Done" will not select any image. The 
objects on the page are automatically shown against a light 
blue background where you can edit them as required.
If instead you wish to have a background image, select the re-
quired image and then click "Done" :

The image is now as follows. You can change the name of the 
page (for instance, "Windows 001"), then click "Next" :
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Appearance of 
Rolling shutter 
Buttons

This page, called "Appearance of Rolling shutters" allows you 
to edit these properties :

    • Images
    • Button text
    • Options

Images

The "Images" area has two options :

    • Skin
    • Images

If you select "Skin" and click the drop-down menu, you can 
then choose between these options :
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If you select "Images" you can select an image to be assigned 
to the button :

On the next page you can select the image you wish to use :

Select the required image and click "Done".
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Button text

This option allows you to attribute text to the button.
Select the "Display text on selected button" checkbox in the 
"Button text" area. You can now edit these parameters :

    • Colour
    • Size
    • Alignment

Click in the box next to "Colour" to select the colour of the 
text:

Click in the rectangles next to "Size" to select the size of the 
text :
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Click in the rectangles next to "Alignment" to select where to 
put the text, at the centre, to the left or to the right :
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Options

The "Options" window allows you to determine whether the 
buttons are read-only or configurable. 
A "read" button cannot be assigned variables, while a "read-
and-write" one can.
The default image is :

The "Read and write buttons" offers three choices:

    • "Show the rolling shutter adjustment pop-up window" 
(a pop-up bar appears that allows you to adjust the in-
tensity) :

    • "Revert mode": this option allows you to change the 
mode at each press of the button. For instance, if the 
button is assigned closing/opening with an intermediate 
step, pressing it the first time opens the rolling shutter 
half way, and pressing it again fully opens the rolling 
shutter.

    • "Show the increase and decrease buttons". In this case 
you can display the "increase and decrease" buttons for 
opening/closing the rolling shutter on the left or on the 
right of the button used for the project :
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Appearance of 
Curtain Buttons

After configuring the appearance of the "Rolling shutter" but-
tons, click "Next" to open the page called "Appearance of cur-
tains" and edit the following :

    • Images
    • Button text
    • Options

Images

The "Images" area has two options :

    • Skin
    • Images

If you select "Skin" and click the drop-down menu, you can 
then choose between these options :

If you select "Images" you can select an image to be assigned 
to the button :

On the next page you can select the image you wish to use :
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Select the required image and click "Done".

Button text

This option allows you to attribute text to the button.
Select the "Display text on selected button" checkbox in the 
"Button text" area. You can now edit these parameters :

    • Colour
    • Size
    • Alignment

Click in the box next to "Colour" to select the colour of the 
text:
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Click in the rectangles next to "Size" to select the size of the 
text :

Click in the rectangles next to "Alignment" to select where to 
put the text, at the centre, to the left or to the right :
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Options

The "Options" window allows you to determine whether the 
buttons are read-only or configurable. 
A "read" button cannot be assigned variables, while a "read-
and-write" one can.
The default image is :

Appearance of 
Window 
Buttons

After configuring the appearance of the "Curtains" buttons, 
click "Next" to open the page called "Appearance of windows" 
and edit the following : 

    • Images
    • Button text
    • Options
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Images

The "Images" area has two options :

    • Skin
    • Images

If you select "Skin" and click the drop-down menu, you can 
then choose between these options :

If you select "Images" you can select an image to be assigned 
to the button:

On the next page you can select the image you wish to use :
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Select the required image and click "Done" :

Button text

This option allows you to attribute text to the button.
Select the "Display text on selected button" checkbox in the 
"Button text" area. You can now edit these parameters :

    • Colour
    • Size
    • Alignment

Click in the box next to "Colour" to select the colour of the 
text:
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Click in the rectangles next to "Size" to select the size of the 
text :

Click in the rectangles next to "Alignment" to select where to 
put the text, at the centre, to the left or to the right :
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Options

The "Options" window allows you to determine whether the 
buttons are read-only or configurable. 
A "read" button cannot be assigned variables, while a "read-
and-write" one can.
The default image is :

Technical view of 
Windows page 
objects

After configuring the appearance of the buttons, click "Next" 
to open the page called "Technical view of windows", featuring 
all the respective objects :
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Click the blue button above "Objects" in the top left-hand cor-
ner of the page. A tree menu opens where you can select the 
technical view of the buttons created :

On the same page, click the blue button above "Properties" in 
the top right-hand corner. A tree menu opens allowing you to 
view the properties of the button selected in the left-hand me-
nu (Objects) :
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You can also modify the position of the button on the page 
using the X and Y variables, and edit the width and height of 
the button using the W and H variables.
You can edit the values in the same 3 ways described earlier 
on:

    • Click in the box containing the number next to the va-
riable you wish to edit, and type in the required number

    • Click on the triangle to the right of the box. Click and 
drag the triangle to the right until you see the required 
number

    • Click on the horizontal line to the right (or left) of the 
triangle and keep clicking until you see the required 
number

You can also use the + and - buttons at the bottom of the page 
to zoom in or out of the page :

If you wish to move a button, you can use the mouse by pla-
cing the cursor on the button, clicking and dragging it to the 
required place on the page.
Double-clicking on an object opens a page where you can edit 
its properties :
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Configuring the 
Window page 
variables

On the "Technical View" page, click "Next" to open the "Varia-
ble configuration" page :

You will notice the objects on the page are pink in colour. This 
means they have not yet been assigned a variable. The first 
thing to do, therefore, is to create a variable (see chapter 4, 
“Creating a new variable” page 53).
After creating the variable (in the example, called "curtain" 
and assigned to the button for opening/closing the curtains), 
select it with the mouse and drag it onto the selected button :
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The button changes colour. The pink image disappears. You 
can move the cursor over the button to view the properties of 
the assigned variable :

Follow the same procedure to assign variables to the other 
buttons, after of course having created the variables concer-
ned (see chapter 4, “Creating a new variable” page 53).

On the "Variable configuration" page, you can view the objects 
in 2 different ways :

    • Page mode (by clicking the respective button) :
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    • List mode (by clicking the respective button) :

The parameters of the objects can be edited in both cases 
(modifying the reading/writing status by assigning different 
variables, managing variables, creating and eliminating varia-
bles, modifying the "open" and "closed" variables, etc.).

After entering all the data on the "Variable configuration" pa-
ge, click "Done" to return to the MyVision main page.

Click on the icon to watch the video for this section :
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Creating a 
Video page

The "Video" page allows you to manage surveillance cameras.
To create a video page, start by clicking the "New page wi-
zard" button (see chapter 4, “Creating a new page” page 51).

On the next page, use the mouse to select the "video" icon :

You will see :

The "Number of cameras" option allows you to manage up to 
4 objects (cameras) for each page you have created.
You can edit the number of cameras in the same three ways 
described previously :
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    • Click in the box containing the number next to "Number 
of cameras" and type in the required number

    • Click on the triangle to the right of the box. Click and 
drag the triangle to the right until you see the required 
number

    • Click on the horizontal line to the right (or left) of the 
triangle and keep clicking until you see the required 
number

If for instance you wish to add one camera, you will see :

Technical view 
of Video page

When you have done, click "Next". This window appears (Te-
chnical View). You can choose between three options :

    • View the elements as a simple set of buttons (in this ca-
se you can also select the background colour)

    • View the elements against a background image (in this 
case you can select a background image)

    • You can also give the page a title by editing the "Title" 
field
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If you select "View the elements as a simple set of buttons", 
you can select a background colour by clicking the white box 
"Select background colour"  the window is now as follows :

If you select the "View the elements against a background 
image", the window is as follows :

On the same page, you can select a background image by cli-
cking the blue rectangle "Select background image" :
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At this point, clicking "Done" will not select any image. The 
objects on the page are automatically shown against a light 
blue background where you can edit them as required.
If instead you wish to have a background image, select the re-
quired image and then click "Done" :

The image is now as follows. You can change the name of the 
page (for instance, "Video 001"), then click "Next" :
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Camera 
Properties

Clicking "Next" opens the "Camera properties" page shown 
below which lists all the available cameras (in the example, 
only one camera has been created) :

The "Camera properties" page allows you to do the following :

    • Edit the name of the camera
    • Add a description
    • Enter the address of the camera
    • Test the camera
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You MUST enter an address for the camera to be included in 
the project. Enter the webcam's IP address in the window 
shown below (in the example, the address is 172.19.7.130), 
then test it by clicking the "Test" button :

The webcam image appears :

Click "Done" to return to the MyVision main page.

Click on the icon to watch the video for this section :

Creating an 
Access page

The "Access" page allows you to manage various access points 
and sensors simultaneously.
To create an Access page, start by clicking the "New page wi-
zard" button (see chapter 4, “Creating a new page” page 51).

Next, click the "Access" icon :
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You will see :

The "Number of access points" option allows you to manage 
up to 40 objects (access points) for each page you have cre-
ated.
The "Number of sensors" option allows you to manage up to 
40 objects (sensors) for each page you have created.
You can edit the number of access points and sensors in the 
same three ways described previously:
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    • Click in the box containing the number next to "Number 
of access points" or "Number of sensors" and type in the 
required number

    • Click on the triangle to the right of the box. Click and 
drag the triangle to the right until you see the required 
number

    • Click on the horizontal line to the right (or left) of the 
triangle and keep clicking until you see the required 
number

If for instance you wish to add one access point and one sen-
sor, you will see :

Technical view 
of Access 
control page

When you have done, click "Next". This window appears (Te-
chnical View). You can choose between three options :

    • View the elements as a simple set of buttons (in this ca-
se you can also select the background colour)

    • View the elements against a background image (in this 
case you can select a background image)

    • You can also give the page a title by editing the "Title" 
field
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If you select "View the elements as a simple set of buttons", 
you can select a background colour by clicking the white box 
"Select background colour"  the window is now as follows :

If you select the "View the elements against a background 
image", the window is as follows :
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On the same page, you can select a background image by cli-
cking the blue rectangle "Select background image" :
                                    

At this point, clicking "Done" will not select any image. The 
objects on the page are automatically shown against a light 
blue background where you can edit them as required.
If instead you wish to have a background image, select the re-
quired image and then click "Done" :
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The image is now as follows. You can change the name of the 
page (for instance, "Access 001") then click "Next" :

Appearance of 
Access control 
buttons

The page, called "Appearance of access points", allows you to 
edit the following :

    • Images
    • Button text
    • Options
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Images

The "Images" area has two options :

    • Skin
    • Images

If you select "Skin" and click the drop-down menu, you can 
then choose between these options :

If you select "Images" you can select an image to be assigned 
to the button :

On the next page you can select the image you wish to use :
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Select the required image and click "Done".

Button text

This option allows you to attribute text to the button.
Select the "Display text on selected button" checkbox in the 
"Button text" area. You can now edit these parameters :

    • Colour
    • Size
    • Alignment

Click in the box next to "Colour" to select the colour of the 
text:
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Click in the rectangles next to "Size" to select the size of the 
text :

Click in the rectangles next to "Alignment" to select where to 
put the text, at the centre, to the left or to the right :
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Options

The "Options" window allows you to determine whether the 
buttons are read-only or configurable. 
A "read" button cannot be assigned variables, while a "read-
and-write" one can.
The default image is :

Appearance of 
Sensors 
buttons

After configuring the properties of the "Access control" but-
tons, click "Next" to open the "Sensor appearance" page and 
edit the following :

    • Images
    • Button text
    • Options
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Images

The "Images" area has two options :

    • Skin
    • Images

If you select "Skin" and click the drop-down menu, you can 
then choose between these options :

If you select "Images" you can select an image to be assigned 
to the button :

On the next page you can select the image you wish to use :
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Select the required image and click "Done".

Button text

This option allows you to attribute text to the button.
Select the "Display text on selected button" checkbox in the 
"Button text" area. You can now edit these parameters :

    • Colour
    • Size
    • Alignment

Click in the box next to "Colour" to select the colour of the 
text:
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Click in the rectangles next to "Size" to select the size of the 
text :

Click in the rectangles next to "Alignment" to select where to 
put the text, at the centre, to the left or to the right :
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Options

The "Options" window allows you to determine whether the 
buttons are read-only or configurable. 
A "read" button cannot be assigned variables, while a "read-
and-write" one can.
The default image is :

Technical view of 
Access control 
page objects

Click "Next" to open the "Technical View" page that displays 
all the objects concerned :
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Click the blue button above "Objects" in the top left-hand cor-
ner of the page. A tree menu opens where you can select the 
technical view of the buttons created :

On the same page, click the blue button above "Properties" in 
the top right-hand corner. A tree menu opens allowing you to 
view the properties of the button selected in the left-hand me-
nu (Objects) :
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You can also modify the position of the button on the page 
using the X and Y variables, and edit the width and height of 
the button using the W and H variables.
You can edit the values in the same 3 ways described earlier 
on:

    • Click in the box containing the number next to the va-
riable you wish to edit, and type in the required number

    • Click on the triangle to the right of the box. Click and 
drag the triangle to the right until you see the required 
number

    • Click on the horizontal line to the right (or left) of the 
triangle and keep clicking until you see the required 
number

You can also use the + and - buttons at the bottom of the page 
to zoom in or out of the page :

If you wish to move a button, you can use the mouse by pla-
cing the cursor on the button, clicking and dragging it to the 
required place on the page.
Double-clicking on an object opens a page where you can edit 
its properties :
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Configuring 
Access control 
page variables

On the "Technical View" page, click "Next" to open the "Varia-
ble configuration" page :

You will notice the objects on the page are pink in colour. This 
means they have not yet been assigned a variable. The first 
thing to do, therefore, is to create a variable (see chapter 4, 
“Creating a new variable” page 53).
After creating the variable (called "Access" in the example), 
select it with the mouse and drag it onto the selected button :
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The button changes colour. The pink image disappears. You 
can move the cursor over the button to view the properties of 
the assigned variable :

Follow the same procedure to assign variables to the other 
buttons, after of course having created the variables concer-
ned (see chapter 4, “Creating a new variable” page 53).

On the "Variable configuration" page, you can view the objects 
in 2 different ways :

    • Page mode (by clicking the respective button) :
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    • List mode (by clicking the respective button) :

The parameters of the objects can be edited in both cases 
(modifying the reading/writing status by assigning different 
variables, managing variables, creating and eliminating varia-
bles, modifying the "blocked"  "released" "with alert" "without 
alert" variables, etc.).

After entering all the data on the "Variable configuration" pa-
ge, click "Done" to return to the MyVision main page.

Click on the icon to watch the video for this section :
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Editing the 
project 
components

You can, at any time, add, edit or delete elements and con-
nections in the hardware configuration of a project by clicking 
the "Project tree" bar on the left-hand side of the MyVision 
main page :

Clicking the "Project tree" bar opens the main MyVision editing 
window. Here you can manage both the project and the ESA 
device by clicking the "Project" or "Device" buttons respecti-
vely at the bottom of the "Project tree" :
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Floor, Area, 
Room, Network 
point

It is logical to assume that a floor in a house can be divided in 
two areas, a "day area" and a "night area".
The "day area" can consist of rooms such as a lounge and ki-
tchen, while the "night area" can feature two bedrooms and a 
bathroom.
An ESA device controls the two areas (in the example, on "Flo-
or 1").
The elements described above are shown as follows :
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Each element of the Project tree can be associated with one of 
the following "Network points" :

Adding a floor There are two ways of adding one or more floors to a project 
tree :

1) Right-click the floor in the project and select "Add a new 
floor" :
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2) Click the "Create a new floor" icon at the bottom of the 
Project tree :

This window appears in both cases :
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Renaming a 
floor

It is possible to rename the floors in the project by right-cli-
cking them :

This window appears. Enter the new name and click "OK" :

The floor on the project tree is renamed :
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Adding an area There are two ways of adding an area to a project (the area is 
usually added to a floor) :

1) Right-click the floor in the project and select "Add a new 
zone" :

2) Click the "Create a new zone" icon at the bottom of the 
Project tree :

The new area appears on the project tree under "Office":

Renaming an 
area

Right-click an area to rename it :
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This window appears. Enter the new name and click "OK" :

The area on the project tree is renamed :

To view the elements in the "day area", double-click the latter 
and this will "light up" as if its windows are lit up.
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In the example, no elements appear as none have yet been 
added.

Adding a room There are two ways of adding a room to a project (the room 
is usually added to an area) :

1) Right-click the area in the project and select "Add a new 
room" :

2) Click the "Create a new room" icon at the bottom of the 
Project tree :

The new room appears on the project tree under the "Day 
area" :

Renaming a 
room

Right-click a room to rename it :
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This window appears. Enter the new name and click "OK" :

The room is re-named on the project tree, under the "Day 
area" :

To view the elements in the "day area", double-click the latter 
and this will "light up" as if its windows are lit up :
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Duplicating an 
element of the 
project

It is possible to duplicate the elements of a project. This can 
save time when drafting the project.
If for example you wish to draft a project for a ten-floor hotel, 
you can create the first floor with a device, rooms and objects 
then, following a simple procedure, duplicate it the required 
number of times (e.g. 10), and rename the elements on each 
floor accordingly.
As an example, you wish to draft a project for a ten-floor hotel 
with ten rooms on each floor, and with management of air 
conditioning and closing of the door for each room.

You add a room with a "HVAC" point and an "access point":

Renaming a 
Network Point

To rename elements in each room ("Network Point"), right-cli-
ck the object you wish to rename and select "Properties" :

This window appears. For instance, replace the name "New 
HVAC" with "HVAC 101" for room 101, then press "Ok" :
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Follow the same procedure for renaming the "Access point" :

Right-click and duplicate room 101 :
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Repeat the duplication procedure 9 times for all 10 rooms on 
Floor 1, and rename rooms 102 to 110 (see chapter 4, “Rena-
ming a room” page 231) :

Each room of course has "HVAC" objects and a "Access point", 
these were added before room 101 was duplicated.
Rename the objects in each room (see chapter 4, “Renaming 
a Network Point” page 233).
In the example, rooms 108, 109 and 110 are opened (by dou-
ble-clicking each one) :
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You can duplicate "Floor 1" now that all its rooms and 
"network points" have been created, these will just have to be 
renamed.
Right-click the floor to duplicate and select the "Duplicate" op-
tion:

The duplicated floor will appear below floor 1. Its name is the 
same, so you need to edit it (see chapter 4, “Renaming a flo-
or” page 228).
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You now duplicate the floor another 8 times, for the total of 10 
floors. You then change all the names (see chapter 4, “Rena-
ming a floor” page 228) :

In the example, floors 2 and 3 are opened (by double-clicking 
each one) :
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Open, for example, room 304 (double-click it) to check it has 
the "network points", "HVAC 304" and "Entrance 304" :
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Moving a device The ESA device (YTAT) is on floor 1 :
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If for example you wish to move the device to floor 10, right-
click to select it and click "Move" :

This window appears :

Select the new position of the device, in this case, "Floor 10", 
and confirm by pressing "OK":
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The device immediately appears on "Floor 10" on the project 
tree :

Adding a device If you used the "Wizard" to create a project in MyVision (see 
chapter 4, “Creating a project with the Wizard” page 19), you 
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should have already assigned a device. You can check this by 
double-clicking the floor on the Project tree :

There are two ways of adding a device to control, say, the "Of-
fice" floor :

1) Right-click the floor and select "Add a new device" :

2) Click the "Create a new device" icon at the bottom of the 
Project tree :

In both cases, a window appears where you need to select the 
device model and alignment (vertical or horizontal). When you 
have done, click "OK" :
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The new device appears on the project tree under the "Office" 
floor :

Click the device. A large green arrow appears indicating the 
next step to be taken, which is "Create a new page for this pa-
nel" (see chapter 4, “Creating a new page” page 51).

Click on the icon to watch the video for this section :

Test Device MyVision allows you to test the entire project you have crea-
ted, in other words to simulate the home system to be set up 
in the building.

There are two ways of opening the "runtime simulator":
MyVision - User Manual - rev. 2.0



Chapter 4

Project Management 

244

MyVision 
1) On the "Device" menu, click "Test device":

2) Click the "Test device" icon at the top on the main icon bar :

In both cases, MyVision automatically compiles the project 
and this window appears, providing all the parameters have 
been entered correctly :
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The runtime simulator opens immediately after the compila-
tion image, allowing the user to execute a "real-time" test of 
all the pages in the project :

Runtime 
simulator

There are two ways of executing a runtime simulation from 
the window shown above :

1) By enabling the objects in the project from the "ESA Run-
Time Simulation" window :
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For example, enable "Kitchen light" and click "Edit Value" to 
change the value of the tag from 0 to 1, then click "OK" :

You will note the "Kitchen light" in the object view on the main 
page of the project lights up as soon as the value of the tag is 
changed from 0 to 1 :
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2) By enabling the objects directly from the project page di-
splayed by the "runtime" simulation. For example, you can 
turn on the same light (the room light) by clicking the respec-
tive button directly :

Clicking the “Navigation bar arrows” :

Displays a sequence of icons. Pressing an icon opens the res-
pective project page, for example, click the "Bathroom" icon 
for heating :
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This opens the page for configuring the temperature in this 
room :

After setting the required temperature, click the "MyVision" 
icon in the bottom left-hand corner to scroll through the pages 
and simulate the operation of the entire home system. If for 
example you wish to simulate running of the irrigation system, 
simply click the respective icon :
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This opens the main page featuring the buttons for controlling 
the irrigation system. Click one of these buttons to simulate 
irrigation in the area assigned during the project :

Click on the icon to watch the video for this section :

Transferring a 
project to the 
device

When you have completed a project (and tested it with the 
runtime simulator) you can transfer it to the ESA device.
There are two ways of transferring the project :

1) On the "Device" menu, click "Transfer project to device" :
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2) Click the "Transfer to device" icon at the top on the main 
icon bar :

In both cases, MyVision automatically compiles the project 
and this window appears, providing all the parameters have 
been entered correctly. Click "Next" :
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The "Connection parameters" page opens. Click the drop-
down menu and select the type of connection between the PC 
and ESA device for executing the download.

Please note that ESA YT4x devices do not have a USB-B port 
and therefore do not support USB connection; you can howe-
ver use a CVNET11002 cable (or a crossover network cable).

If you choose a "USB" connection, as in the example, you need 
to connect a "USB-A/USB-B" cable to the PC (provided by ESA 
in the "MyVision" programming kit):
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After selecting the option, click "Next" :

The "Configuration Runtime" window appears displaying the 
components of the project and the drivers of the ESA device 
(hard disk, free space and space required for downloading the 
project).

MyVision generates files during the compilation process. If 
there is already a resident project on the device you intend to 
transfer a project to, MyVision compares the files on the devi-
ce with the new ones to be transferred. The "Configuration 
Runtime" page allows you to select, during the download pro-
cess, whether to update all the files or only the old ones.

This procedure is useful in that, if you only make a small chan-
ge to the project, you can transfer just the amended part ra-
ther than the entire project. This can save a lot of time.
Make your selection and click "Next":
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The project is now transferred to the ESA device. Lastly, click 
"Done" :

Click on the icon to watch the video for this section :
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